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1 General
1.1 About this manual
This manual describes the hardware, software, and usage of the portable GISmonitor in its current version.

Software updates are available on Power Diagnostix’s website (www.pdix.com). Access to the download area 
of this website is password protected and requires a valid software maintenance contract. Contact Power 
Diagnostix for details (support@pdix,com). Revisions of this manual and current brochures are also available 
for download (Adobes PDF format) on this website.

1.2 Instrument safety
Before using the GISmonitor, read the following safety information and this manual carefully. In particular, 
read and follow the information, which is marked with the words ‘Warning’ and ‘Caution’. The word ‘Warning’ 
is reserved for conditions and actions that pose hazards to the user, while the word ‘Caution’ is reserved for 
conditions and actions that may damage the instrument, or its accessories, or that may lead to malfunction.

Always obey the safety rules given with the warnings on the unit and in this guide. Make sure to take care of 
the safety issues while performing field measurements. Never disregard safety considerations, even under 
the time constraints often found with on-line and off-line tests on site.

 z Always ensure solid grounding of the instrument. Never operate the instrument 
without protective grounding.

 z Use isolation techniques, such as isolation transformers or fibre optic isolation 
to avoid hazard and injury. With applications bearing a high risk of electrical 
shock or breakdown, use fibre optic isolation in general.

 z Do not work alone.

 z Do not allow the instrument to be used if it is damaged or its safety is impaired.

 z Inspect the ground leads and signal cables for continuity.

 z Select the proper coupling circuit and connection for your application.

 z Do not use the instrument in an environment where there is risk of condensation 
or risk of explosion.

Warning

https://www.pdix.com
mailto:support%40pdix%2Ccom?subject=
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2 Hardware
2.1 Standard models
The GISmonitor unit comes in a portable, lightweight desktop enclosure of half (Figure 2.1) or 2/3 19 inch or a 
shock resistant and watertight Explorer case (Figure 2.2 and Figure 2.3) for outdoor use. All connectors nec-
essary for measurement and remote control via a personal computer are accessible on the front or top side 
of the instrument.

Figure 2.1: GISmonitor in a half 19-inch desktop enclosure

Figure 2.2: Eight-channel GISmonitor in an outdoor 
case

Figure 2.3: 40-channels GISmonitor in an outdoor case
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2.2 Optional features
2.2.1 Monitoring server

Built-in monitoring web server providing an Ethernet gateway for platform-independent remote access to 
stored measurement data of a portable GISmonitor instrument.

2.2.2 Mobile communication interface MCI2

The mobile communication interface allows remote access to the GISmonitor Portable via UMTS. This option 
is available as additional module.
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3 Installation
The GISmonitor Portable allows the partial discharge detection on external or embedded ultra-high frequency 
(UHF) sensors. With this application, the special UHF frequency converter unit FCU is closely connected to 
the sensor’s output. At best, to avoid any unnecessary attenuation, this connection is made rather using an 
N-N adapter than a cable.

The input protection unit IPU2B protects the measurement system from high voltages generated by switching 
operations, transients, or overvoltage.

Figure 3.1: Input protection unit IPU2B; IP52 (left) and IP65 model (right)

The signal is then transformed by a frequency converter unit (FCU2) into a lower frequency range for easy 
submission over longer distances.

The transformed signal is transmitted by use of 50 Ohm coaxial cable (RG58 for indoor use, RG142 for out-
door use) and digitised by the GISmonitor Portable, which offers the acquisition of up to 40 sensors in paral-
lel (depending on the instrument’s model).

Figure 3.2: Frequency converter unit FCU2 (IP52 and IP65 model)
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3.1 Connections
The connections to the GISmonitor Portable are made on the front or on the top panel of the instrument. The 
half 19-inch desktop model and the eight-channel Explorer version offer ten SMB or BNC connectors, one 
USB-B connector, and a LAN connector. If the GISmonitor is housed in an Explorer case, the mains supply 
and the wing nut screw for grounding are on the instrument’s top side, whereas the desktop model offers 
these connectors on the rear panel. 

The functions of the connectors are described in the following sections.

3.1.1 Desktop model and eight-channel Explorer version

CH1–CH8: These connectors take the PD signal coming from a frequency converter unit (FCU).

SYNC: The SYNC is used for external synchronisation to the frequency of the applied high voltage. 
This signal is usually derived from voltage transformers or different coupling units. This ter-
minal can take voltages up to ca.100 V RMS or ca. 200 Vpeak. If the SYNC is not connected, 
the GISmonitor must be set to “Internal Synchronisation” and will synchronise on the mains 
supply frequency (usually 50 or 60 Hz), then.

GATE: The GATE terminal can be used for noise rejection during measurements. For this, an addi-
tional FCU connects the unwanted noise signal with the GATE. To pick up these signals, a 
DA2 can be used as an antenna. The DA2 is equipped with a built-in FCU.

Mains supply: The mains power supply plug must be connected to a power outlet providing power in the 
voltage range 85 V AC up to 264 V AC, frequency 47 to 440 Hz. The on/off switch for the unit 
is located underneath the mains plug. A power supply fuse is located between the on/off 
switch and the mains power inlet.

GND: The wing nut of the GISmonitor must be connected to earth/ground.

USB: The USB port provides a USB connection to a personal computer for remote communica-
tions. A standard USB A-B cable is included in the delivery.

LAN: The LAN connector is a standard RJ45 connector for Ethernet and provides a connection to 
a personal computer for remote communications. The LAN module is pre-configured with an 
IP address and a port.

Figure 3.3: GISmonitor Portable installed on a GIS
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3.1.2 Explorer version with up to 40 channels

CH1.1–CH5.8: These connectors take the PD signal coming from a frequency converter unit (FCU).

SYNC: The SYNC is used for external synchronisation to the frequency of the applied high voltage. 
This signal is usually derived from VTs or different coupling units. This terminal can take 
voltages up to ca.100 V RMS or ca. 200 Vpeak. If the SYNC is not connected, the GISmonitor 
must be set to “Internal Synchronization” and will synchronise on the mains supply frequency 
(usually 50 or 60 Hz), then.

ANT1–ANT3: The ANT terminals can be used for noise suppression during measurements. A gating signal 
can be picked up using the disturbance antenna DA2 with a built-in frequency converter unit. 
Up to three gating signals can be connected at a time and are mixed to one disturbance 
signal.

GATE OUT: Output of the mixed disturbance signal (of ANT1–ANT3).

Mains supply: The mains power supply plug must be connected to a power outlet providing power in the 
voltage range 85 V AC up to 264 V AC, frequency 47 to 440 Hz. The on/off switch for the unit 
is located underneath the mains plug. A power supply fuse is located between the on/off 
switch and the mains power inlet.

GND: The wing nut of the GISmonitor must be connected to earth/ground.

USB: The USB port provides a USB connection to a personal computer for remote communica-
tions. A standard USB A-B cable is included in the delivery.

LAN: The LAN connector is a standard RJ45 connector for Ethernet and provides a connection to 
a personal computer for remote communications. The LAN module is pre-configured with an 
IP address and a port.

Figure 3.4: Panel of a 40-channel GISmonitor
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Figure 3.5: Example setup without external synchronisation
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4 The GISmonitor Portable software
4.1 Introduction
The GISmonitor software visualises the current readings of the partial discharge sensors of a gas-insulated 
switchgear (GIS) and indicates PD events or system notifications. Each sensor is linked with a specific input 
channel of a GISmonitor.

4.2 Operation
The GISmonitor collects and stores the data of each connected sensor. This collected data is analysed by 
the GISmonitorServer software and presented to you in a variety of different visualisations in the  GISmonitor 
viewer software. The software can operate in three modes. The default is the monitoring mode, in which 
trending data and system data are collected and stored in a database. Events will be created depending 
on pre-configured thresholds and several types of events are being logged. The manual mode is used for 
in-depth live visualisation and manual analysis of the current measurement data. Storing of the automated 
trending data and event creation is stopped as long as the manual mode is active. The maintenance mode 
stops the automated creation of events as well as the recording of measurement data during maintenance 
or rectification works.

4.2.1 Connecting to the instrument

The connection with the GISmonitor instrument can be made either by USB cable or by RJ45 cable (LAN). For 
the LAN connection, the user must set the IP address of the Ethernet port in the software (if the laptop was 
provided by Power Diagnostix, the port has already been set adequately).

To set up the IP address, take the following steps:

1. Right-click on the Windows start menu and select “Network Connections” from the context menu.

2. In the “Network Connections” window, locate the network adapter whose IP address you want to config-
ure and right-click on it. Then select “Properties”.

3. Locate “Internet Protocol Version 4 (TCP/IPv4)”, right-click on it, and select “Properties”.

4. Select the option “Use the following IP address” and enter the following information:

 z IP Address: 192.168.20.99 (many others can be used but we strongly suggest to use this one.)

 z Subnet Mask: 255.255.255.0

 z Default Gateway: This can be left empty.

Click “OK” to save the settings.

5. Now the PC should be able to connect to the instrument.

4.2.2 Starting the software

The GISmonitor Portable software can be started via the link on the desktop, the Windows Explorer, or the 
Windows Start/Programs menu. Subsequently, the main panel appears as shown in Figure 4.1.

Please note: You get the best possible view with a display zoom of 100 % at full HD.
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4.2.3 Monitoring mode

In the upper left-hand corner is a context sensual quick settings toolbar. Settings that can be changed are the 
unit (dBµV or dBm) that the software will display and the displayed range of visualised measurement data.

4.2.3.1 Overview

The GISmonitor software starts in the “Overview” tab. The sensors are visualised by small coloured horizontal 
bars as shown in the figure below:

Figure 4.1: Overview schematic with all sensors being off-line

The sensor colours can be changed in the “Color Settings” 
menu under “Edit”. Default settings are green, yellow, and 
blue for appropriately working sensors of different phases. 
Black or grey sensors indicate false initiation or no connec-
tion to the related GISmonitor. In case the connection between 
the  GISmonitor and a frequency converter unit (FCU) is lost, a 
flashing orange frame will appear around the associated bar. 
In case of a low-level PD warning, the sensors colour will turn 
to orange, in case of a high-level PD warning, it will turn to red.

Figure 4.2: Colour settings
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Double-clicking on a sensor displays a window showing the previous trending data and the current measure-
ment values of this sensor.

On the upper left-hand side, the name of the sensor is 
displayed. The last average value and last pulse peak 
value of the sensor are shown as well as the configured 
event thresholds. On the upper right-hand side an ac-
cumulated pattern is displayed. The graph beneath 
shows the average and pulse peak trending values for 
the last six minutes. If “History” is selected in the “Show 
Trending” dropdown list, the data of the last month can 
be viewed. To get more detailed information about the 
sensor, the analysis panel can be opened by clicking 
the “Analysis” button. The analysis panel provides the 
complete trending data and allows the comparison be-
tween different sensors (see also section 4.2.5).

Press the “Print” button to either print the current panel 
or to save it as a file on the laptop.

Press the “Copy” button to copy the content of the win-
dow to the clipboard.

Pressing the “>>” button enlarges the window and 
displays a larger pattern.

Figure 4.3: Sensor details
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4.2.4 Live analysis

Up to 15 sensors can be selected in the overview tab and viewed simultaneously by clicking on the “Live 
Analysis” tab. The upper part of the panel shows a trending graph that depicts the average and pulse peak 
values of all selected sensors. In the lower part the patterns for the selected sensors are shown.

Figure 4.4: Panel for live analysis
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4.2.5 Historic analysis

For a detailed analysis of the trending data, please select the “Historic Analysis” tab. Up to 15 sensors can 
be selected in the overview.

The upper part of the panel shows the trending graphs for the average and pulse peak value, and the lower 
part shows the patterns of the selected sensors for the selected cursor position. Moving the cursor of the 
graphs will show the values at the new cursor position and will display the pattern next to this time.

Zooming and shifting of the graph in x-direction is done by selecting either the specific time or selecting the 
pre-defined interval and pressing the “Set Range” button. The “Full Range” button sets the zoom of the graph 
to a level, that the full range of the selected interval is shown.

By pressing the “Export Trending” button, the measurement data can be saved as an *.xlsx file.

The “Copy Screenshot” button will copy the content of the window to the clipboard. “Export Screenshot” will 
save the content of the window as a *.jpg file.

Figure 4.5: Panel for the historic analysis
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4.2.6 Alert and warning events list

Figure 4.6: Events list

All alerts and warnings are stored and can be displayed in the events list, which can be accessed via the 
“Events” tab in the tab menu of the GISmonitor application. The “PD Warnings” list on the upper left-hand side 
displays the high-level and low-level warnings of all sensors. By clicking on a specific event, the correspond-
ing coloured pattern is shown on the upper right-hand side. High-level and low-level warnings are triggered 
independently, relying on the respective alert threshold. Events are grouped and can contain several smaller 
events, depending on how long the threshold was surpassed. Each event of the group can be inspected 
separately by pressing the “<” or “>” button. Pressing the “<<” button will select the first event of the group, 
while pressing the “>>” button will select the last event. The “General Events” list at the bottom displays all 
maintenance and hardware events. Each event is tagged with a timestamp and provides information about 
the location, the type of error, and a short description. To acknowledge an event, you can click the “Set 
Timestamp” button, which will tag the event with date and time of acknowledgement.

Sensor high-level and low-level events as well as maintenance and hardware alerts can be reset by using the 
“Reset” buttons next to the respective list.

The event lists can be exported as .xlsx files by clicking the “Export Warnings” or “Export Events” button. The 
list shows the alarm and warning events sorted by the time they occurred.
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4.2.7 Configuration of the monitor mode

Power Diagnostix provides the GISmonitor software completely set up and individually configured for your 
GISmonitor Portable, so, generally, there is no need to change the following options.

Please be aware that changing the set-up might corrupt the software functionality by worsen the detec-
tion and identification of partial discharges or preventing alarm and warning outputs.

Some changes will lead to a temporary disconnection between the laptop and the GISmonitor instrument. No 
data will be recorded during this timeframe.

4.2.7.1 General settings

The General Settings menu can be opened via 
“Edit” -> “General Settings”. The input field 
“Setup” allows the configuration of the settings 
regarding the presentation of PD patterns. For 
instance, the lower level of detection (LLD) can 
be set individually depending on the level of the 
background noise. The constant phase shift of 
the displayed patterns referring to the synchro-
nisation voltage can be defined for each phase.

In the centre of the dialogue box, the synchro-
nisation and gating settings for the GISmonitor 
Portable can be adjusted. The synchronisation 
can be switched between line and external syn-
chronisation to avoid long cables for synchro-
nisation.

In case a disturbance antenna (DA2) is used, 
external gating can be enabled, and a threshold 
can be defined. This will provide suppression of 
noise created by cell phones, corona effects, 
and similar.

At the bottom of the dialogue box the settings for the trending data analysis can be adjusted. The acquisition 
interval of trending can be selected. Depending on the settings for saving trending data and patterns to the 
hard disk, the estimated memory requirements are calculated, and the time till depletion of disk space is 
given.

Figure 4.7: General settings window
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4.2.7.2 Device settings

The settings for the connection between the GISmonitor software, the GISmonitor instrument (or its plug-in 
boards), and the UHF sensors can be adjusted in the “Device Settings” dialogue box. This dialogue box is 
opened by selecting the “Edit” -> “Device Settings” menu item.

Figure 4.8: Device settings

General settings can be modified on the right-hand side. Enter the settings for the selected GISmonitor in the 
fields there. First a name of this GISmonitor can be assigned. Then the type of connection to this GISmonitor 
must be chosen, “USB” or “Lan”. The default setting is “Lan”, and the default port for the GISmonitor is 10002. 
The IP address must be selected according to the setting of the corresponding GISmonitor. The typical value 
for “IP Address” is 192.168.20.1xx (xx represent the last two digits of the serial number found on the instru-
ment or the respective plug-in board). Newer revisions of the GISmonitor can be restarted with the software 
by clicking on the “Restart Device” button at the top of the settings, otherwise the button is disabled.

Click on the “Configure FCUs” button to set the type of the FCU which is connected to a particular sensor, 
e.g., FCU2 for UHF embedded sensors or FCU3 for high frequency current transformers (HFCTs).

Figure 4.9: FCU configuration window
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4.2.7.3 Alert settings

The alarm settings can be configured by selecting the “Edit” -> ”Alert Settings” menu item. The dialogue box 
that appears is shown in the figure below:

Figure 4.10: Alert settings

The average and pulse peak values that trigger a low-level or high-level alert can be set individually. By sur-
passing this level, the measurement data will be evaluated using the respective detection level. The minimal 
count rate defines the number of pulses above the required detection level in a specified acquisition time to 
trigger an alert/warning event.

These alert settings can be defined for up to 16 groups in which 
the sensors can be included. Click on “Add Group” to create a 
new group. Pressing “Remove Group” will delete the currently 
selected group.

Please note: Group 1 (default) can’t be deleted. To assign a 
sensor to another group, press the “Define Groups” button and 
then click on the sensor’s group entry to move the sensor to 
the desired group.

A recommended configuration will be set up by Power Diag-
nostix during commissioning.

Figure 4.11: Alarm group association
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4.2.7.4 Administrative settings

For maintenance purposes, such as installing the software or Windows updates, it may be necessary to re-
start or close the GISmonitorServer software. This can only be done on the laptop by pressing the “Start” or 
“Stop GISmonitorServer” buttons. The manual shutdown of the GISmonitorServer will disable the watchdog, 
which restarts the software in case of a failure. It will automatically be enabled when the GISmonitorServer is 
started again, or the laptop gets restarted.

To ensure that only authorised people change the settings of the software, a password can be requested. To 
enable this option, press the “Enable Password” button. If you choose this option, you have to set an admin-
istrator password. This opens a dialogue box prompting for a password.

Figure 4.12: Administration settings

If a password is enabled, it can be disabled by pressing the “Disable Password” button and entering the 
current administrator password.

If an administrator password is enabled, changes of settings must be verified with this password. It is also 
required to enable or disable the maintenance mode.
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4.2.7.5 Preferences

The GISmonitorServer settings can be modified in the preferences window. The GISmonitor software con-
nects to the GISmonitorServer software running on the laptop and controls it. If the option for the built-in 
monitoring web server is included, the IP address will be 192.168.20.2, otherwise, the address 127.0.0.1 
should be used.

The application settings can be modified to display the date or time format to the desired format.

Figure 4.13: Preferences window

The GISmonitor software requires a data directory which will be used to save files for high voltage (HV) tests or 
the sensitivity check, as well as temporary files for use with the ICMexpert software. The folder can be select-
ed with the “Data Directory” button. If the ICMexpert functionality should be used, the ICMexpert application 
has to be installed on the computer, and the application has to be linked by selecting it with the “ICMexpert” 
button.

The GISmonitorServer usually monitors the GIS using the monitoring mode. If the manual mode is used, a 
timeout has to be defined, after which the GISmonitorServer automatically switches back to the monitoring 
mode. To do so, modify the inactivity timeout. If the manual mode is used for a HV test or sensitivity check, 
this timeout will be ignored. Please be aware that the use of the manual mode stops the continuous monitor-
ing including the storing of data for the time that the manual mode is active.
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4.2.8 Manual mode

For commissioning purposes, the GISmonitor software offers a special commissioning display, which shows 
relevant data in three different modes: A view for normal operation, a view for HV tests, and a view to perform 
the sensitivity verification. The manual mode can be started by pressing the “Manual Mode” indicator at the 
top of the window.

4.2.8.1 Sensor configuration

The “Configure Sensors” button in the toolbar of the application window in manual mode lets you change the 
displayed sensor names (default is CH1, CH2, etc.) for an easy identification of the different sensors. Addi-
tionally, the configuration window offers the possibility to change the phase shift for every sensor.

Figure 4.14: Toolbar of the application window in manual mode

Figure 4.15: Window for sensor configuration
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4.2.8.2 Measurement

By selecting the measurement tab, up to 24 sensors show the scope and pattern displays of partial discharge 
activities versus phase position as black and white or coloured patterns. Additionally, for every sensor, the 
recorded PD scope values of the last 50 periods can be shown as continuous 3D view or a larger phase-re-
solved partial discharge (PRPD) pattern by double clicking on a sensor.

Figure 4.16: Measurement tab of the commissioning panel

The sensors, the data for which should be dis-
played in the commissioning panel, can be select-
ed from the  GISmonitor interface in the monitoring 
mode or by pressing the “Layout” button of the 
commissioning panel. Depending on the screen 
resolution, the settings of the currently selected 
sensor are shown beneath or next to the patterns.

The current view can be saved as PNG or BMP 
file to hard disk with the “Export Screenshot” but-
ton or can be copied to clipboard with the “Copy” 
button.

Figure 4.17: 3D view of sensor data



pdix.comUser guide for GISmonitor Portable26

GISmonitor Portable
Portable partial discharge monitor

4.2.8.3 HV test

The HV test is performed on site before a GIS is finally energised. Different bays of the GIS are energised one 
after the other, and the UHF sensors located in these GIS sections are checked for PD signals originating 
from possible defects. This menu allows the operator to select the relevant sensors and record possible par-
tial discharge signals as well as the profile of the applied voltage. This creates a playback that can serve as 
a fingerprint of the GIS and can be checked and viewed as many times as desired.

By selecting the “HV Test Mode” tab, a dedicated mode for HV testing purposes is opened. In the HV test 
mode, the synchronisation is enforced to “external”, and the phase shift of each sensor is set to 0 °. First the 
“Test Section” that is under testing has to be named. Afterwards, by pressing the “Start Recording” button, 
every scope image, every pattern image, and the measured voltage are stored for the duration of the recording.

Figure 4.18: HV tests tab

After applying an external voltage, the measured voltage can be calibrat-
ed with the “Calibrate Voltage” button. A click on the “Stop Recording 
button finishes the HV test for the current section. Afterwards, all data is 
processed and saved in the data directory, which is specified in the pref-
erences.

Figure 4.19: Voltage adjustment
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To review a measurement, use the “View” -> “HV Replay” menu item. This replay view can load and display 
up to 24 hvt files. Depending on how many files are shown, the software displays either just the recorded 
images or the images and, next to them, a trending graph including pulse peak values and the recorded 
voltage. If only images are shown, the corresponding trending graphs can be displayed by clicking on the 
“Trend” button in the menu bar at the top of the panel. To display only the images again, press the “Image” 
button.

Figure 4.20: HV tests panel with trending graphs active

The recorded HV measurement can be replayed with the “Play” button. Additionally, the cursor in the trending 
graph can be moved to replay the measurement at a faster speed or to show specific sections of the meas-
urement.
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4.2.8.4 Sensitivity check

By selecting the “Sensitivity Check” tab, up to six sensors can be used to perform the sensitivity verification.

The sensitivity check menu/feature has been developed in order to ease the commissioning activities for the 
so called ‘sensitivity verification’ step. Before the HV test can be performed on site, it is necessary to perform 
the sensitivity verification in order to ensure that the UHF sensors are able to pick up a signal coming from a 
possible defect located inside the GIS enclosure. This is done by injecting with a calibrator into a sensor and 
reading the signal from the closest sensors. Since a GIS can have hundreds of sensors, the sensitivity check 
menu helps keeping track of every sensor that has been checked.

Figure 4.21: Panel for sensitivity checks with one tab for every phase

First a given injection sensor must be chosen from the “Injection Sensor” dropdown list, or the name of an 
injection sensor can be entered. The signal of the injected voltage should be visible at the nearest sensors to 
verify that a fault that occurs between these sensors can be detected. The value of “Injection Voltage” should 
be set to the voltage injected by the calibrator CAL2B. 

The software takes a single shot measurement (scope image), a 3D series of 50 
accumulated scope images, or a PRPD pattern (map), depending on the selec-
tion in the “Record” dropdown list of the toolbar.

Figure 4.22: Record modes
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By pressing the “Capture” button, the software will take the appropriate recording. After the measurement, a 
pop-up window will be shown, and the measurement can be stored in the data directory with the “Ok” button.

Figure 4.23: Saving sensitivity check data

The software offers the creation of an automated report 
for completed sensitivity checks. A click on the “Create 
Report” button of the “Sensitivity Check” tab brings up a 
report window for the choice of the data directory. Click-
ing the “Create Report” button of the report window will 
create a Word file and paste in all the measurement data 
including the scope images, 3D series images, and the 
PRPDs.

Figure 4.24: Window for creating a sensitivity check re-
port 
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5 Miscellaneous
5.1 Maintenance
The GISmonitor Portable does not require any regular maintenance. Firmware or software updates can be 
requested from Power Diagnostix.

The following actions are recommended as software maintenance:

 z Windows updates to prevent unwanted failures of the operating system

 z Regularly updates of antivirus programs

 z Updates of the GISmonitor Portable software if necessary

5.2 Product marks
This symbol indicates that the product should not be disposed of as normal household 
waste. As it is a B2B product, it may also not be disposed of at civic disposal centres. If 
you wish to dispose of this product, please do so properly by taking it to an organisation 
specialising in the disposal of old electrical equipment near you.

Any batteries installed must be disposed of separately from the unit.

As a responsible manufacturer, certified according to ISO 14001, Power Diagnostix offers to take back old 
instruments from its customers. Please contact Power Diagnostix at support@pdix.com to discuss the pro-
cedure for this.

5.3 Shipment instructions
In case a unit needs to be returned to the factory, make sure the acquisition unit is packed safely. As the units 
are relatively small, shipment by couriers, such as DHL, FedEx, or equivalent is the recommended mode of 
transportation. If possible, declare the instrument as ‘used instruments for evaluation’ at a relative low value. 
Consult Power Diagnostix for further details. Power Diagnostix may provide you with a temporary replacement 
unit in case of urgent needs.

mailto:support%40pdix.com?subject=
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5.4 Declaration of Conformity

The manufacturer 
Power Diagnostix Instruments GmbH 
Vaalser Strasse 250 
52074 Aachen 
Germany

declares that the product

GISmonitor Portable

Portable partial discharge monitor

provided it is installed, maintained, and used for which it was made, in accordance with relevant installation 
standards and manufacturer’s instruction, meets the requirements of the following directive(s):

Low Voltage Directive 2014/35/EU 
EMC Directive 2004/108/EG 
RoHS Directive 2011/65/EU

It complies with the following standards and/or normative documents:

EN 61010-1:2020 
EN 61326-1:2013 
EN IEC 63000:2018

Aachen, 10/04/2024 
Dr. Mihai Huzmezan 
(CEO, Power Diagnostix Instruments GmbH)

Remark: Since the measurement of partial discharge pulses is done in frequency bands partly occupied by 
radio transmission, and since test leads may act as antennas, disturbance free measurements may require 
well-shielded environments and/or additional filter techniques.
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5.5 UK Declaration of Conformity

The manufacturer 
Power Diagnostix Instruments GmbH 
Vaalser Strasse 250 
52074 Aachen 
Germany

declares that the product

GISmonitor Portable

Portable partial discharge monitor

provided it is installed, maintained, and used for which it was made, in accordance with relevant installation 
standards and manufacturer’s instruction, meets the requirements of the following Statutory Instruments:

SI 2016 no. 1101 The Electrical Equipment (Safety) Regulations 2016
SI 2016 no. 1091 The Electromagnetic Compatibility Regulations 2016
SI 2012 no. 3032 The Restriction of the Use of Certain Hazardous Substances in Electrical and Elec-

tronic Equipment Regulations 2012

It complies with the following standards and/or normative documents:

EN 61010-1:2020 
EN 61326-1:2013 
EN IEC 63000:2018

Aachen, 10/04/2024 
Dr. Mihai Huzmezan 
(CEO, Power Diagnostix Instruments GmbH)

Remark: Since the measurement of partial discharge pulses is done in frequency bands partly occupied by 
radio transmission, and since test leads may act as antennas, disturbance free measurements may require 
well-shielded environments and/or additional filter techniques.
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6 Technical data
6.1 Acquisition unit
6.1.1 Half 19-inch desktop model for 8 or 16 channels

Mains supply: 100–240 V AC, 47–440 Hz (automatic)

Line fuse : 1.6 A time-lag

Power requirements: Approx. 25 VA

Input impedance (PD): 50 Ohm//50 pF

Input sensitivity: < 1 mV

Synchronisation: VT input, 20–350 Hz

Interfaces: USB, TCP/IP

Operation temperature: 10–40 °C (non-condensing)

Signal input: 8–16 SMB connectors (50 Ohm)

Gate input: 1–2 SMB connector (50 Ohm)

Sync input: 1–2 SMB connector, 100 V RMS into 10 MOhm//200 pF

6.1.2  2/3 19-inch desktop model for 8, 16, or 32 channels

Mains supply: 90–240 V AC, 50–60 Hz (automatic)

Line fuse: 2 A time-lag

Power requirements: Max. 70 W

Input impedance (PD): 50 Ohm//50 pF

Input sensitivity: < 1 mV

Synchronisation: VT input, 20–350 Hz

Interfaces: USB, TCP/IP

Operation temperature: 10–40 °C (non-condensing)

Signal input: 8–32 SMB connectors (50 Ohm)

Gate input: 1–3 SMB connector (50 Ohm)

Sync input: 1–3 SMB connector, 100 V RMS into 10 MOhm//200 pF

6.1.3 Eight-channel Explorer model

Mains supply: 100–240 V AC, 47–440 Hz (automatic)

Line fuse: 1.6 A time-lag

Power requirements: Approx. 25 VA

Input impedance (PD): 50 Ohm//50 pF
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Input sensitivity: < 1 mV

Synchronisation: VT input, 20–350 Hz

Interfaces: USB, TCP/IP

Operation temperature: 10–40 °C (non-condensing)

Signal input: 8 BNC connectors (50 Ohm)

Gate input: 1 BNC connector (50 Ohm)

Sync input: 1 BNC connector, 100 V RMS into 10 MOhm//200 pF

6.1.4 Explorer model for 16, 24, 32, and 40 channels

Mains supply: 85–264 V AC, 47–440 Hz (automatic)

Line fuse: 1.6 A time-lag 
0.5 A time-lag

Power requirements: Approx. 100 VA

Input impedance (PD): 50 Ohm//50 pF

Input sensitivity: < 1 mV

Operation temperature: 0–40 °C (non-condensing)

Synchronisation: VT input, 20–350 Hz

Interfaces: USB, TCP/IP

Operation temperature: 10–40 °C (non-condensing)

Signal input: 16–40 BNC connectors (50 Ohm)

Gate input: 1–3 BNC connectors (50 Ohm)

Sync input: 1 BNC connector, 100 V RMS into 10 MOhm//200 pF

6.2 Housing
6.2.1 Desktop enclosure half 19-inch

Material: Coated cast aluminium

Overall size: 236 x 132 x 296 mm3 (W x H x D, excl. BNC connectors)

Weight: Approx.4 kg (depending on the numbers of channels)

6.2.2 Desktop enclosure 2/3 19-inch

Material: Coated cast aluminium

Overall size: 325 x 132 x 296 mm3 (W x H x D, excl. BNC connectors)

Weight: Approx.5,5 kg (depending on the numbers of channels)
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6.2.3 Eight-channel outdoor case

Material: Hardened polypropylene

Overall size: 305 x 144 x 270 mm3 (W x H x D, closed) 
305 x 360 x 270 mm3 (W x H x D, open)

Weight: Approx. 3.2 kg

6.2.4 Outdoor case with up to 40 channels

Material: Hardened polypropylene

Overall size: 670 x 510 x 372 mm3 (W x H x D, closed)

Weight: Approx. 23 kg (depending on the numbers of channels)

6.3 FCU2
Frequency range: Typ. 100–1800 MHz

Input impedance: 50 Ohm//50 pF

Input sensitivity: <200 µV at 500 MHz (-61 dBm at 500 MHz)

Output signal: 2 MHz (approx., depends on input signal)

Roll-off: 40 dB/dec

Input connector: N-Plug

Output connector: BNC plug (IP52 model) 
TNC plug (IP65 model)

Operation temperature: -10–60 °C (non-condensing)

Overall size: 26 x 26 x 87 mm3 (IP52 model)
(H x W x D) 35 x 35 x 107 mm3 (IP65 model)

Weight: Approx. 80 g (IP52 model) 
Approx. 160 g (IP65 model)

Power requirements: 11–15 V DC, 0.31 W

Enclosure: IP52: aluminium; HF sealed 
IP65: aluminium; waterproof and HF sealed
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6.4 IPU2B
Transient over voltage protection

Input connector: N-Plug

Output connector: N-Jack (IP52 model) 
N-Plug (IP65 model)

Operation temperature: -10–60 °C (non-condensing)

Overall size: 26 x 26 x 64 mm3 (IP52 model)
(H x W x D) 35 x 35 x 81 mm3 (IP65 model)

Weight: Approx. 80 g (IP52 model) 
Approx. 145 g (IP65 model)

Enclosure: IP52: aluminium; HF sealed 
IP65: aluminium; waterproof and HF sealed
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